Before using this information and the product it supports, read the information in "Notices" on page 15.
Contents

Introduction .................................. v

Chapter 1. Installing and Configuring IBM Cognos PowerPlay Client ............... 1
  Verify System Requirements ........................................... 1
  Installing and Configuring IBM Cognos PowerPlay Client ..................... 2
    Install IBM Cognos PowerPlay Client ................................ 2
    Configure IBM Cognos PowerPlay Client .................................. 3
    Test the Installation ........................................... 5
  Uninstall IBM Cognos PowerPlay Client ................................... 6

Chapter 2. Configuration Options ........................................... 7
  Change a URI ................................................... 7
  Change Cryptographic Settings ......................................... 9
  Configure SSL Protocol ............................................ 9

Chapter 3. Setting Up the Samples for IBM Cognos PowerPlay Client .............. 11
  Install the IBM Cognos Samples ................................... 11
    Installing the samples ........................................ 11
    Adding samples to the PowerPlay Client computer ....................... 12
  Test a Sample Report in IBM Cognos PowerPlay Client ................... 12

Appendix. Accessibility features ........................................... 13
  Keyboard Shortcuts for the Installation Wizard .................................. 13

Notices ................................................... 15

Index ............................................. 19
Introduction

This document is intended for use with IBM® Cognos® PowerPlay® Client. Cognos PowerPlay Client is a Business Intelligence (BI) solution that you can use to create, view, explore, format, and distribute reports.

This guide contains instructions about installing and testing PowerPlay Client, and about setting up samples.

For information about the differences to IBM Cognos Series 7, see the *IBM Cognos PowerPlay Client User Guide*.

Audience

To use this guide, you should have basic Windows administration skills.

Finding information

To find IBM Cognos product documentation on the web, including all translated documentation, access one of the [IBM Cognos Information Centers](http://pic.dhe.ibm.com/infocenter/cogic/v1r0m0/index.jsp). Release Notes are published directly to Information Centers, and include links to the latest technotes and APARs.

You can also read PDF versions of the product release notes and installation guides directly from IBM Cognos product disks.

Accessibility features

IBM Cognos PowerPlay Client does not currently support accessibility features that help users who have a physical disability, such as restricted mobility or limited vision, to use this product. IBM Cognos HTML documentation has accessibility features. PDF documents are supplemental and, as such, include no added accessibility features.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are not currently available may be included. No implication of any future availability should be inferred. Any such references are not a commitment, promise, or legal obligation to deliver any material, code, or functionality. The development, release, and timing of features or functionality remain at the sole discretion of IBM.

Samples disclaimer

The Sample Outdoors Company, Great Outdoors Company, GO Sales, any variation of the Sample Outdoors or Great Outdoors names, and Planning Sample depict fictitious business operations with sample data used to develop sample applications for IBM and IBM customers. These fictitious records include sample data for sales transactions, product distribution, finance, and human resources. Any resemblance to actual names, addresses, contact numbers, or transaction values is coincidental. Other sample files may contain fictional data manually or
Chapter 1. Installing and Configuring IBM Cognos PowerPlay Client

This section provides the information you need to install and configure IBM Cognos PowerPlay Client.

You can install PowerPlay Client on the same computer as other IBM Cognos Business Intelligence components or on a different computer. PowerPlay Client is available as a 32-bit installation only. You can install PowerPlay Client on a 64-bit Microsoft Windows computer. Do not install PowerPlay Client in the same directory as 64-bit IBM Cognos BI components.

This section also includes information about uninstalling PowerPlay Client.

For information about the differences between IBM Cognos Series 7 PowerPlay and IBM Cognos PowerPlay Client, see the IBM Cognos PowerPlay Migration and Administration Guide.

To install and configure PowerPlay Client, do the following tasks:

- Verify system requirements.
- Install PowerPlay Client.
- Configure PowerPlay Client, if required.
- Test the installation.

You are now ready to use PowerPlay Client. If you would like to try some of the features with sample data, you can install and configure the PowerPlay samples. For more information, see Chapter 3, “Setting Up the Samples for IBM Cognos PowerPlay Client,” on page 11.

Verify System Requirements

Use the following table to check the minimum hardware and software requirements to install and run IBM Cognos PowerPlay components on one computer. Additional resources may be required for distributed or production environments.

Table 1. Minimum hardware and software requirements for installing IBM Cognos PowerPlay Client

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAM</td>
<td>Minimum: 2 GB</td>
</tr>
<tr>
<td>Disk space</td>
<td>A minimum of 2.5 GB of free space is required to install the software and 1 GB of free space on the drive that contains the temporary directory used by IBM Cognos Business Intelligence components.</td>
</tr>
</tbody>
</table>
Table 1. Minimum hardware and software requirements for installing IBM Cognos PowerPlay Client (continued)

<table>
<thead>
<tr>
<th>Requirement</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser</td>
<td>For all web browsers, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• cookies</td>
</tr>
<tr>
<td></td>
<td>• JavaScript</td>
</tr>
<tr>
<td></td>
<td>For Microsoft Internet Explorer only, the following are enabled:</td>
</tr>
<tr>
<td></td>
<td>• Active scripting</td>
</tr>
<tr>
<td></td>
<td>• Allow META REFRESH</td>
</tr>
</tbody>
</table>

Installing and Configuring IBM Cognos PowerPlay Client

This section provides the information you need to install and configure IBM Cognos PowerPlay Client. PowerPlay Client lets you create, view, explore, format, and distribute PowerPlay reports in the IBM Cognos Business Intelligence environment.

If you are upgrading from a previous release of PowerPlay Client you have two choices.

- Uninstall the existing version of PowerPlay Client before you install the new version. If you choose this option, backup data from the installation location that you want to save, such as reports, before you run the uninstall program.
- Install the new version of PowerPlay Client to a different location so you can continue to use the existing version. You may choose this option if you plan to continue to use the existing IBM Cognos BI production environment while you install and test the new version.

**Note:** The default installation location for PowerPlay Client version 10 is different from previous versions.

Use the following checklist to guide you through the required tasks to install and configure PowerPlay Client:

**Procedure**

1. Install PowerPlay Client
2. Configure PowerPlay Client
3. Test PowerPlay Client

Install IBM Cognos PowerPlay Client

Use the installation wizard to install IBM Cognos PowerPlay Client on a Microsoft Windows computer.

You can have IBM Cognos Series 7 PowerPlay for Windows and IBM Cognos PowerPlay Client on the same computer. This can be useful when migrating reports from IBM Cognos Series 7 to IBM Cognos BI. When both products are installed on the same computer, file associations are set up to launch the product that was installed most recently when a PPX or MDC file is accessed. If you install IBM Cognos Series 7 PowerPlay for Windows after installing IBM Cognos PowerPlay Client, you can reset the file associations so that PPX and MDC files open in IBM Cognos PowerPlay Client.
**Procedure**

1. Do one of the following:
   - Insert the IBM Cognos PowerPlay Client disk.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click `issetup.exe`.
   - Go to the location where the installation files were downloaded and extracted and double-click `issetup.exe`.

2. On the **Welcome** page of the installation wizard, select one of the available languages and then click **Next**.
   The language you select determines the language of the installation wizard.

3. In each **License Agreement** page, select **I Agree** and then click **Next**.

4. In the **Installation Location** page, specify the IBM Cognos BI location.
   - If you do not use the default installation location, specify a directory name that contains only ASCII characters.

5. In the **User Information** page, specify the settings and click **Next**.

6. In the **Product Language Selection** page, select the language for the product user interface and then click **Next**.
   Only one language can be selected per installation. We recommend using a language that matches the system locale settings. Otherwise, use English. We also recommend setting fonts to match the system locale. Ensure that the supporting font is installed on the client computer.

7. In the **Component Selection** page, accept the default settings and click **Next**.

8. Follow the directions in the **Shortcut Folder** and **Installation Summary** pages.

9. In the **Finish** page
   - Select **View the Release Notes**, if you want to see late-breaking information about IBM Cognos PowerPlay Client.
   - Click **Finish**.

**Reset File Associations to IBM Cognos PowerPlay Client**

If you install IBM Cognos Series 7 PowerPlay for a Microsoft Windows operating system after you install IBM Cognos PowerPlay Client and you want PPX and MDC files to open in IBM Cognos PowerPlay Client, you must update the registry setting that controls which application opens the files.

**Procedure**

Open a command prompt window and run the following command in the `powerplay_client_installation_location\bin` directory:

```
PwrPlay.exe /regserver
```

**Configure IBM Cognos PowerPlay Client**

After you install IBM Cognos PowerPlay Client, configure the software so that it works in your environment.

If you install PowerPlay Client to use with local PowerCubes only, no configuration is required.

Before you configure PowerPlay Client, ensure that IBM Cognos Business Intelligence server components are installed and configured: Content Manager, application tier components, and gateway. This ensures that the certificate...
authority service on the Content Manager computer can issue a certificate to the PowerPlay Client and that PowerPlay Client can communicate with the gateway.

Contact your IBM Cognos Business Intelligence administrator for the required configuration information.

**Configure Access to the IBM Cognos PowerPlay Server**

Configuration is required if you want to use remote PowerCubes as your data source.

To publish reports to IBM Cognos Connection, you must use remote PowerCubes.

To prevent errors ensure that you use the same format for URI settings in both the IBM Cognos PowerPlay Client installation and the IBM Cognos PowerPlay Server installation. For example, use a fully qualified domain name for all URI settings. Do not use a machine name in one configuration and a fully qualified domain name in the other configuration.

**Procedure**

1. On the computer where you installed PowerPlay Client, start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, in the **Gateway URI** box, change the host name portion from localhost to either the IP address or network host name of the gateway computer.
4. Specify the value for the **Dispatcher URI for external applications**.
5. If the default password was changed on the Content Manager computer, use the following steps:
   - In the **Explorer** window, under **Cryptography**, click **Cognos**.
   - Under the **Certificate Authority settings** property group, for the **Password** property, type the same password specified on the default active Content Manager computer.
6. From the **File** menu, click **Save**.

**Restrict port communication between IBM Cognos PowerPlay Client and the Remote PowerPlay Services**

PowerPlay Client connects to the remote PowerPlay service through the IBM Cognos BI gateway. After establishing a connection through the gateway, by default, PowerPlay uses the first dynamic port available for communication between PowerPlay Client and the remote PowerPlay services. In some environments, you might need to restrict communication to specific ports, such as when a firewall separates the PowerPlay Client computer and the PowerPlay service computer. To restrict port numbers, you must complete configuration in IBM Cognos Administration on the PowerPlay service computer and on each PowerPlay Client computer.

**Setting a port number for the PowerPlay service computer:**

You use IBM Cognos Administration to set a port number for the PowerPlay service.
Procedure
1. Start IBM Cognos Administration.
2. On the Configuration tab, click Dispatchers and Services.
3. Click a dispatcher name to show a list of services.
4. In the Actions column, click the Set properties icon for the PowerPlay Service.
5. Click the Settings tab.
6. In the Value column, click Edit for the Environment category.
7. Click Override the settings acquired from the parent entry.
8. Type the following parameter and value:
   Parameter= SRV.PPDSRM.ServerPort, Value= IN,n where n is the restricted port number, such as 8010. For example, the Parameter is set to SRV.PPDSRM.ServerPort, and the value is set to IN,8010
9. Click OK on the Set advanced settings page.
10. Click OK on the Set properties page to save the configuration change.

Setting a port number for the PowerPlay Client computers:

You can edit a configuration file to set a port number for PowerPlay Client computers.

Procedure
1. On each PowerPlay Client computer, from the powerplay_client_installation_location\configuration directory, open ppds_cfg_xml.sample in a text or xml editor.
2. Locate the following section:
   <Section value="PPDSRemote">
   <Port value="0"/>
   <NATTimeout value="-1"/>
   </Section>
3. Change the port value to the restricted port number, such as 8000.
   Note: Use a different port than the one set as an advanced setting of the PowerPlay service.
4. Save the file, changing the name to ppds_cfg.xml.

Test the Installation

You can test the IBM Cognos PowerPlay Client installation and configuration by opening PowerPlay and connecting to a remote package.

Procedure
1. From the Start menu, under Programs, IBM Cognos 10, click PowerPlay. If the Welcome page for PowerPlay appears, the installation is successful.
2. To test the connection to the PowerPlay Server, on the Welcome page, click Create a new report.
3. Click Remote.
4. If prompted, provide your authentication information.
5. Select a package and then click OK.
Results

PowerPlay Client opens the data source and the title bar indicates a remote connection and data source name.

Uninstall IBM Cognos PowerPlay Client

It is important to use the IBM Cognos Business Intelligence uninstall programs to remove IBM Cognos Business Intelligence products. Do not use the Microsoft Windows Add or Remove Programs tools.

Uninstalling does not remove any files that changed since the installation, such as configuration and user data files. Your installation location remains on your computer, and you retain these files until you delete them manually.

Before you begin

We recommend that you close all programs before you uninstall IBM Cognos Business Intelligence products. Otherwise, some files may not be removed.

Procedure

1. From the Start menu, click Programs, IBM Cognos 10, Uninstall IBM Cognos, Uninstall IBM Cognos. Uninstall Wizard appears.
2. Follow the instructions to uninstall the components.
   The cognos_uninst_log.txt file records the activities that the Uninstall wizard performs while uninstalling files. This log file is created in the temp directory.
3. Delete all temporary Internet files.
   For more information, see your web browser documentation.
Chapter 2. Configuration Options

After the installation and initial configuration of IBM Cognos PowerPlay Client, you may need to change configuration settings. Changes are only required when configuration settings change in the IBM Cognos Business Intelligence environment. For example, you must update the PowerPlay Client configuration if cryptographic settings change on the Content Manager computer.

Common configuration changes include:
- Change a URI
- Configure cryptographic settings
- Add security to your communications using the Secure Sockets Layer (SSL) protocol

Change a URI

You can change certain elements in a URI depending on your environment.

When you install IBM Cognos Business Intelligence components, the installation uses default configuration settings. If you have any reason not to use the default values, such as a port is being used by another process, use IBM Cognos Configuration to change the value.

An IBM Cognos URI contains the following elements:
- For a Gateway URI
  protocol://host_name_or_IP:port/virtual_directory/gateway_application
  OR
  protocol://host_name_or_IP:port/context_root/alias_path
- For a Dispatcher URI for external applications
  protocol://host_name_or_IP:port/context_root/alias_path

Table 2. List of elements and descriptions

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>protocol</td>
<td>Specifies the protocol used to request and transmit information, either Hyper Text Transfer Protocol or Hyper Text Transfer Protocol (Secure).</td>
</tr>
</tbody>
</table>
Table 2. List of elements and descriptions (continued)

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>host name or IP</td>
<td>Specifies the identity of the host on the network. You can use an IP address, a computer name, or a fully qualified domain name.</td>
</tr>
<tr>
<td>For example,</td>
<td></td>
</tr>
<tr>
<td>localhost or 192.168.0.1</td>
<td>In a distributed installation, you must change the localhost element of a URI.</td>
</tr>
<tr>
<td></td>
<td>In a mixed environment of UNIX and Windows servers, ensure that host names can be resolved to IP addresses by all servers in the environment.</td>
</tr>
<tr>
<td>port</td>
<td>Specifies the port on which the host system listens for requests.</td>
</tr>
<tr>
<td>For example,</td>
<td>The default port for Tomcat is 9300. The default port for a web server is 80.</td>
</tr>
<tr>
<td>9300 or 80</td>
<td></td>
</tr>
<tr>
<td>context root</td>
<td>Used by Tomcat or an application server to determine the context of the application so that the request can be routed to the correct web application for processing.</td>
</tr>
<tr>
<td>For example,</td>
<td></td>
</tr>
<tr>
<td>p2pd</td>
<td></td>
</tr>
<tr>
<td>alias path</td>
<td>Used by the application server to route a request to the correct component within a web application.</td>
</tr>
<tr>
<td>For example,</td>
<td>The alias path must not be modified or IBM Cognos BI components cannot function properly.</td>
</tr>
<tr>
<td>servlet/dispatch</td>
<td></td>
</tr>
<tr>
<td>virtual directory</td>
<td>Used by the web server to map a virtual directory or alias to a physical location.</td>
</tr>
<tr>
<td>For example,</td>
<td></td>
</tr>
<tr>
<td>ibmcognos or ibmcognos/cgi-bin</td>
<td>For example, in the default Gateway URI of <a href="http://localhost:80/ibmcognos/cgi-bin/cognos.cgi">http://localhost:80/ibmcognos/cgi-bin/cognos.cgi</a>, the virtual directory is ibmcognos/cgi-bin</td>
</tr>
<tr>
<td>gateway application</td>
<td>Specifies the name of the IBM Cognos BI gateway application that is used.</td>
</tr>
<tr>
<td>For example,</td>
<td></td>
</tr>
<tr>
<td>cognos.cgi</td>
<td>For example, if you are accessing IBM Cognos BI components using a Common Gateway Interface (CGI), then the default gateway application would be cognos.cgi</td>
</tr>
</tbody>
</table>

**Procedure**

1. Start IBM Cognos Configuration.
2. In the **Explorer** window, click **Environment**.
3. In the **Properties** window, click the **Value** box next to the URI property that you want to change.
4. Select the element and type the new information.
5. From the File menu, click Save.

---

**Change Cryptographic Settings**

Cryptographic keys are used to encrypt passwords and data.

All IBM Cognos Business Intelligence server and client components, including IBM Cognos PowerPlay Client, must use the same cryptographic keys.

During the initial configuration, PowerPlay Client communicates with Content Manager through the gateway to establish trust and obtain cryptographic keys from Content Manager. If the cryptographic keys on the Content Manager computer change, you must update the PowerPlay Client configuration to obtain the new cryptographic keys from Content Manager.

Complete the following steps on each PowerPlay Client computer.

**Procedure**

1. Go to the `powerplay_client_installation_location\configuration` directory.
2. Delete the csk, encrypkeypair, and signkeypair directories.
4. In the Explorer window, under Security, click Cryptography.
5. In the Properties window, update the value of the properties as required to reflect changes in the cryptographic properties on the Content Manager computer.
6. From the File menu, click Save.

**Results**

IBM Cognos Configuration creates new csk, encrypkeypair, and signkeypair directories in the configuration directory.

---

**Configure SSL Protocol**

The Secure Sockets Layer (SSL) protocol is used to secure communication between IBM Cognos Business Intelligence components installed on the same computer or on different computers.

If you configured IBM Cognos PowerPlay Client for access to remote cubes and the PowerPlay servers are configured to use the SSL protocol, you must configure PowerPlay Client to use SSL.

**Before you begin**

All PowerPlay computers in your environment must use the same protocol. For more information about configuring SSL on server computers, see the PowerPlay Installation and Configuration Guide.

**Procedure**

1. Start IBM Cognos Configuration.
2. In the Explorer window, click Environment.
3. Configure the SSL protocol by changing the HTTP portion of the URI to HTTPS and specify the HTTPS port number for either of the following two settings:
   - **Gateway URI**
   - **Dispatcher URI for external applications**
     If the IBM Cognos PowerPlay server uses a different SSL setting than the one you configure, the setting on the server is used.

4. In the **Explorer** window, click **Security, Cryptography, Cognos**.

5. In the **Properties** window, specify a password for the IBM Cognos signing key store:
   - Under **Signing key settings**, click the value for **Signing key store password** and then click the edit button.
   - Type the new password in both boxes and then click **OK**.

6. In the **Properties** window, specify a password for the IBM Cognos encryption key store:
   - Under **Encryption key settings**, click the value for **Encryption key store password** and then click the edit button.
   - Type the new password in both boxes and then click **OK**.

7. From the **File** menu, click **Save**.
Chapter 3. Setting Up the Samples for IBM Cognos PowerPlay Client

IBM Cognos Business Intelligence provides sample reports that contain sales, marketing, and financial information for a fictional company named the Sample Outdoors Company that sells sporting equipment.

The samples are available on a separate disc and are described in the related user guides and online help. To use the samples, you must install and configure them, or contact your administrator to find out where they are installed.

Use the following checklist to guide you through the tasks:

Procedure
1. Install the samples.
2. Test a sample report.

Install the IBM Cognos Samples

The IBM Cognos Samples installation includes a variety of content including: data sources, models, cubes, reports, and other types of content, to support all IBM Cognos Business Intelligence components.

Only some of the samples content is of interest to IBM Cognos PowerPlay users. Instead of adding the entire IBM Cognos Samples installation to the PowerPlay computer, install the samples to a shared network location and then copy relevant content to the PowerPlay computer. Users of other IBM Cognos BI components can copy samples from the same network location.

For a description of the sample cubes and reports, see the PowerPlay Client User Guide.

Installing the samples

Install the samples to a shared network location so other IBM Cognos Business Intelligence users can use content from the samples installation.

Procedure
1. To install the samples, use one of the following options:
   - Insert the IBM Cognos BI Samples disc.
     If the installation wizard does not open automatically, go to the operating system directory, and double-click issetup.exe.
   - Go to the location where the installation files were downloaded and extracted and double-click issetup.exe.
2. Select the language to use for the installation.
3. Follow the directions in the installation wizard to copy the required files to your computer.
4. In the Finish page of the installation wizard, click Finish.
Adding samples to the PowerPlay Client computer

To use samples, copy content from the IBM Cognos Business Intelligence samples installation location to the IBM Cognos PowerPlay Client computer.

Procedure
1. In the webcontent directory of the PowerPlay Client installation, create a new folder called samples.
   If you used the default installation location, the path to the new folder is C:\Program Files\ibm\cognos\c10\webcontent\samples
2. Copy the following content from the IBM Cognos Samples installation to the new samples folder on the PowerPlay Client computer. Do not combine the contents of the report folders for local cubes and remote packages into a single folder.
   - c10_samples_location\webcontent\samples\datasources\cubes\PowerCubes\language\great_outdoors_sales_en.mdc
   - c10_samples_location\webcontent\samples\powerplay_reports\powerplay\reports_for_local_cubes\language
   - c10_samples_location\webcontent\samples\powerplay_reports\powerplay\reports_for_remote_packages\language

Test a Sample Report in IBM Cognos PowerPlay Client

You can test the samples by opening reports in IBM Cognos PowerPlay Client.

To test a report based on a remote package, a sample package must be set up on the PowerPlay installation.

Procedure
1. Start PowerPlay Client.
2. In the Welcome page, click Open an existing report.
3. Choose the type of report you want to open.
   - To open a report located on your computer or a shared network drive, click Local, and then navigate to the report you want to open.
   - To open a remote report, click Remote, and then select the package and report you want to open.

Results
The report opens in PowerPlay.
### Appendix. Accessibility features

Accessibility features help users who have a physical disability, such as restricted mobility or limited vision, to use information technology products.

See the [IBM Accessibility Center](http://www.ibm.com/able) for more information about the commitment that IBM has to accessibility.

### Keyboard Shortcuts for the Installation Wizard

Keyboard shortcuts, or shortcut keys, provide you with an easier and often faster method of navigating and using software.

The installation wizard uses standard Microsoft Windows operating system navigation keys in addition to application-specific keys.

**Note:** The following keyboard shortcuts are based on US standard keyboards.

The following table lists the keyboard shortcuts that you can use to perform some of the main tasks in the installation wizard on the Windows operating system.

*Table 3. List of keyboard shortcuts on a Windows operating system*

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next configuration step</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Return to the previous configuration step</td>
<td>Alt+B</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the installation wizard on the UNIX or Linux operating system.

*Table 4. List of keyboard shortcuts on a UNIX or Linux operating system*

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move to the next field on a page</td>
<td>Tab</td>
</tr>
<tr>
<td>Return to the previous field on a page</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Close the installation wizard</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Move to the next selection in a list</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move to the previous selection in a list</td>
<td>Up arrow</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in the License Agreement page of the installation wizard.
Table 5. List of keyboard shortcuts on the License Agreement page

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accept the license agreement</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Decline the license agreement</td>
<td>Alt+D</td>
</tr>
<tr>
<td>Quit the installation wizard</td>
<td>Alt+x</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a Windows operating system.

Table 6. List of keyboard shortcuts for IBM Cognos Configuration on a Windows operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
<tr>
<td>Display the File menu</td>
<td>Alt+F</td>
</tr>
<tr>
<td>Display the Edit menu</td>
<td>Alt+E</td>
</tr>
<tr>
<td>Display the View menu</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Display the Actions menu</td>
<td>Alt+A</td>
</tr>
<tr>
<td>Display the Help menu</td>
<td>Alt+H</td>
</tr>
</tbody>
</table>

The following table lists the keyboard shortcuts you can use to perform some of the main tasks in IBM Cognos Configuration on a UNIX or Linux operating system.

Table 7. List of keyboard shortcuts for IBM Cognos Configuration on a UNIX or Linux operating system

<table>
<thead>
<tr>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current configuration</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Close IBM Cognos Configuration</td>
<td>Alt+F4</td>
</tr>
<tr>
<td>Rename the selected item</td>
<td>F2</td>
</tr>
</tbody>
</table>
Notices

This information was developed for products and services offered worldwide.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service. This document may describe products, services, or features that are not included in the Program or license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Software Group
Attention: Licensing
3755 Riverside Dr
Ottawa, ON K1V 1B7
Canada

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
IBM, the IBM logo and ibm.com are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:
• Microsoft, Windows, Windows NT, and the Windows logo are trademarks of Microsoft Corporation in the United States, other countries, or both.
• Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.
• UNIX is a registered trademark of The Open Group in the United States and other countries.
• Java and all Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
Index

A
accessibility features 13

C
changing
default configuration settings 7
configuration
changing cryptographic settings 9
changing default settings 7
changing URIs 8
default settings for PowerPlay 7
configuring
connection to the PowerPlay Server 4
port numbers 4
PowerPlay Client 3
SSL protocol 9
cryptographic settings
changing 9

F
file association
updating 3
firewalls
configuring port numbers 4

I
installation
testing samples 12
installing
PowerPlay Client 2
samples 11

K
keyboard shortcuts 13

P
port numbers
configuring 4
restricting 4
ports
changing 8
PowerPlay Client
uninstalling 6

R
registry settings
updating 3

S
samples
installing 11
secure sockets layer,
See SSL protocol
shortcut keys 13
SSL protocol
configuring 9
system requirements 1

T
testing
installation 5
samples 12

U
uninstalling
PowerPlay Client 6
URLs
changing 8